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Getting Started

Once the program is installed and you are able to open the
program, review “Your First Appointment” on page 7 and
work from there.

System Requirements
 Compatible with Windows Vista, XP with Service

Pack 2, and 2003.
 Minimum screen resolution is 1024x768.
 Recommended minimum Pentium 4 or higher
 Recommended minimum RAM is 512MB

Installing the Program
Insert the CD and follow the on screen prompts. The normal
program location is C:\Program Files\EZClaim and the
database location is normally C:\Program Files\EZClaim for
XP or 2003 and C:\Users\Public\Documents\EZClaim if
using Vista.

Opening the Program
Double click the EZClaim Appointment Scheduler icon on
your desktop to start the program.

Registration
When you open the program in trial mode, a registration
box will appear.

Click the ‘Run Program…’ button to continue using the trial.
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If you have purchased the program and have your

registration numbers, click the button
to enter your registration number and Key Code.

Registration Number – Enter the Registration Number
provided by EZClaim at time of purchase.

Key Code – Enter the Key Code provided by EZClaim at
time of purchase.
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Your First Appointment

The Main Screen of EZClaim’s Appointment Scheduler has
an easy to learn and use interface.

The user can easily and quickly ‘drag and drop’ appointments to
any date and time.

Once the appointment is created, you can double click or right
click the appointment to modify the appointment properties.

What’s Next?
We suggest reviewing the following topics in order to help you
setup the program and understand the features.

 “Scheduler Screen Overview” on page 9 – Become familiar
with the icons and screen area names

 “Program Setup” on page 13 – Add doctors (resources), set
your colors and other program options

 “Patients” on page 22 – Add, Edit, and Find patient
information

 “Appointments” on page 26 – Add, Edit, and Find
appointments. Includes setting the appointment attendance
status.
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 “Blocking Appointments” on page 32 – Create blocking
appointments for lunch breaks and other ‘un-available’ times

 “Printing a Schedule” on page 34 – How to print the
schedule

 “View Options” on page 35 – Change the calendar view and
show or hide resources

 “Backup and Restore” on page 37 – How to backup and
restore your scheduling and billing data

Advanced Program Features
 “Reports” on page 39 – Print different schedule formats and

other reports
 “Appointment Templates” on page 41 – Use appointment

templates to quickly create a appointment with certain
properties such as a color, border, or description.

 “Appointment Waiting List” on page 45 – Add patients to a
waiting list and quickly find them when a hole opens up in
the schedule.

 “Tracking Authorizations” on page 47 – Track who is
authorized and who is not.

 “Patient Payments” on page 50 – Entering payments and
printing receipts.

 “Superbill Report” on page 50 – Customizing the superbill
report.

Integration with EZClaim Medical Billing Software
 “EZClaim Integration” on page 50 – Overview of what data is

shared between the two programs
 “Transfer to EZClaim” on page 52 – Transfer appointments

to EZClaim to create claims with the click of the mouse
 “Payer Library” on page 54 – Manage EZClaim’s payer

library within the scheduler
 “Physician Library” on page 55 – Manage EZClaim’s

Physician/Facility library within the scheduler
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Scheduler Screen Overview

 Title Bar
 Version
 Toolbar
 Menu Bar
 Side Bar
 Current Time Indicator

Appointment Items
Each appointment is made up of the following items:

 Heading
 Subheading
 Notes
 Background color
 Border color
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Side Tool Bar
The Side Bar contains items you will use when creating
appointments and navigating the scheduler.

Below the Menu System is the Side Bar. Use this tool bar to
quickly set up your scheduling options. The side tool bar
allows for managing Profiles, Calendar View, Dates,
Resources and Patients.

Patient Information Section
This section has three tabs to provide quick Patient,
Insurance and Appointment information related to the
selected patient. Click on tabs to display information.
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Double click the patient name to open the full patient
information screen.

Tool Bar
The EZClaim Scheduler program uses ‘quick’ tools for
selecting the following options. Click on the tool bar icon to
open the feature.

Previous Patient – Move backward in the list of
patients you have been working on.

Next Patient – Move forward in the list of patients you
have been working on.

New Patient – Create a new patient.

Edit Patient – Edit current patient’s data.

Find Patient – Search for an existing patient.

Previous View – Moves backward in the list of previous
dates/views.

Next View – Move forward in the list of dates/views.

Day View – Sets calendar view to ‘Day View’.
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Work Week View – Sets calendar view to ‘Work Week
View’.

Month View – Sets calendar view to ‘Month View’.

Print Schedule – Quick print of schedule.

Print Preview – Preview schedule before printing

Reports – Brings up the ‘Report’ dialog box.

Program Setup – Brings up the ‘Program Setup’ dialog
box.
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Program Setup

After installing EZClaim Appointment Scheduler, go to

Tools >Program Setup or click on the icon to open the
‘Program Setup’ dialog box. Program Setup includes the
following tabs.

 General Tab – Company information and general
options

 Resources Tab – Doctors, rooms, and/or equipment
that can be scheduled

 Backgrounds and Borders Tab – Appointment colors
 Appointment Templates Tab – Used to quickly setup

different types of appointments
 Profiles Tab – Stores program settings such as

screen color, resource, and calendar views.

General Tab
Enter the Company or Individual name and contact
information under the ‘General’ tab. This information will be
used in tasks such as printing reports. Follow the steps
below.
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1. Enter the following information.
o Company or Individual Name
o Address
o Phone Number
o Fax
o Email

2. Check the option that prompts you to backup
scheduler data regularly.

3. Select the time frame for backing up data. The
normal setting is 7 days.

4. Check the ‘Automatically check for program updates’
to have the program check for updates when
opened.

5. Check the ‘Require a patient…’ if you want every
appointment to have a patient associated with it.

6. Click on the ‘Save’ button to save the changes.
Notice the Save button turns red if information has
changed on the form and needs to be saved.
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Resources Tab

Resources are the ‘Who, What or Where’ that patients could
have an appointment scheduled. Examples would be a
doctor, an exam room or medical equipment. To create a
new resource, follow the steps below. The name of the
resource will be shown at the top of the calendar when
viewing the program.

1. Highlight ‘Sample Doctor’ to edit or click the ‘New’
button.

2. At the bottom of the screen, change the ‘Resource
Name’ to reflect your office requirements. Resource
Name could be a Person, Place or Thing.

3. Select ‘Resource Type’. Note: If the Resource name
is a person, select ‘Person’. If the Resource name is
a place such as an exam room, select ‘Place’. If the
Resource name is related to things/equipment such
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as the ECG or X-Ray equipment, then select ‘Thing’
as the Resource Type.

4. Optional: Select ‘Custom Color’. Custom color may
be selected now or changed at a later time.

5. Continue adding ‘Resources’ by clicking on the
‘New’ button.

6. Click on ‘Save’ button.

When the window is closed, the new resource will be
shown on the scheduler screen. Use the resource drop
down on the side bar to change the active resources.

Deleting Resources
Resources can be deleted by clicking the resource and

clicking the ‘Delete’ button.

Backgrounds and Borders Tab
Note: Backgrounds and Borders may be customized at any
time.

Backgrounds and Borders affect the appearance of the
appointments. Assigning ‘Backgrounds and Borders’ will
assist with quick recognition of various appointment types
when viewing the scheduling program.

To setup ‘Backgrounds and Borders’ follow the steps
below.
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1. Select a background color and rename it to your
office preference. Ex: A color may be selected to
signify a ‘New Patient’ when entered in the
scheduler.

2. Use the color drop down selector if you would like to
change the color.

3. Click on ‘Save’ button.

Note: Backgrounds and Borders cannot be deleted, only the
name and color can be changed.

Appointment Templates Tab
Note: Appointment Templates are an advanced feature.
We suggest getting familiar with other aspects of the
program before setting up appointment templates.

See “Appointment Templates” on page 41 for help in setting
up and using appointment templates.
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Profiles Tab
Note: Profiles may be set up or edited after the user
becomes more familiar with EZClaim Scheduler.

Profiles ‘remember’ which resources are being viewed, along
with the current calendar view and printing preferences.

1. To create additional ‘Profiles’, click on the ‘New’
button.

2. Enter a name for the new profile under ‘Profile
Name’.

3. To select the items for ‘View’, click on the button
next to ‘View’.

4. The expanded options for this Profile’s view are;

Scheduler View Options
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 Group By – Select to group appointments either by
‘Date’ or by ‘Resource’.

 Time Scale – This should be set to your most
common appointment duration. If you normally
schedule 15 minute appointments, enter 15.

 Theme – Using the drop down, select the overall
visual Theme of the scheduler.

 Start Time – Set the ‘Start Time you would like to
view on the schedule by clicking the up or the down
arrow beside the Start Time.

 End Time – Set the ‘End Time’ you would like to
view on the schedule by clicking the up or the down
arrow beside the End Time.

 Visible Patient Groups – Select the groups you
would like visible in the patient drop down list.

 Appt Font Type – Select the ‘Appointment Font’ from
the drop down list.

 Appt Font Size – Select the ‘Appointment Size’ from
the drop down list.

 Hide Appointment Times – Shows or hides the
appointment times on each appointment. Saves
room if you have a large number of appointments.

 Hide Appointment Images – Shows or hides the
appointment icons on each appointment. Saves
room if you have a large number of appointments

 Day View Resource Visibility – If set to dynamic and
using ‘Day View’, the program will automatically hide
the resources that do not have appointments. This
helps when you have a large number of resources
but they work part time. Prevents you changing the
resource visibility all the time.
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Printing Options

Click on button next to ‘Printing’ to select the Printing
options for the specific profile.

 Schedule Printout – Select the Schedule Printout
options from the drop down list. The available
options are Standard, Appointment List, and
Appointment List Detail.

 Printout Orientation – Used when printing the daily
schedule.

 Appt Font Type – Select the Appointment Font Type
from the drop down list of font types.

 Appt Font Size – Select the Appointment Font Size
from the drop down list of font sizes.

 Time Scale Font Type – Select the Time Scale Font
Type from the drop down list of font types.

 Time Scale Font Size– Select the Time Scale Font
Size from the drop down list of font sizes.

 Hide Appointment Times – Shows or hides the
appointment times on each appointment. Saves
room if you have a large number of appointments.
Only works with the ‘Standard’ printout.

 Hide Appointment Images – Shows or hides the
appointment icons on each appointment. Saves
room if you have a large number of appointments.
Only works with the ‘Standard’ printout.

Click on ‘Save’ button to save your changes.
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Additional Profile Tools
To copy and then edit the settings from an existing profile,
click on the ‘Copy’ button. Rename Profile and edit any
options.

A Profile may also be deleted. Highlight the profile to be
deleted and then click on the ‘Delete’ button.
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Patients

Add a New Patient
Methods to open the New Patient Window

 Click the button in the patient selection drop
down on the left side bar.

 Click the New Patient icon on the Toolbar
 Click the Patient menu and select ‘New Patient’
 Click the Patient menu and select ‘New Patient with

Template’

Enter Patient Information
1. The patient’s first and last name is required. All

other fields are optional. Some fields are shared with
EZClaim and you may be able to use dropdown
arrows to select data.

2. Optional: To open the Physician or the Payer Library

click on the button next to the field. For
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additional information regarding Payer and
Physician Library see “EZClaim Integration” on page
50.

3. Once data is entered click on ‘Save’.

New Patient Using a Template
Note: User must have access to the EZClaim program.
Patient Templates are set up in the EZClaim program. See
the EZClaim Manual for ‘Patient Templates’ for more
information on patient templates.

1. Click the Patient menu
2. Select ‘New Patient with Template’. You will see the

following screen

3. Select the template you wish to apply for the Patient.
4. Click on ‘Use’ button.
5. If you click on ‘Cancel’ button, it’s the same as

adding a patient without a template.

Selecting a Patient
In the Patient selection drop down on the side tool bar, begin
typing the patient’s Last name. If the patient is in the list, the
name will auto fill.

Finding a Patient

Other options are to click on the button in the patient

selection drop down or use the Find Patient tool bar
icon to search for an existing patient. The ‘Find Patient’
option is also available in the ‘Patient’ menu.
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As you start typing into the Patient Filter items, the list will
reflect the matching patients.

Editing a Patient
Before editing a patient, you must first select the patient you
wish to edit. There are various ways to ‘Edit’ a patient.

 Select the patient then double click the patient name
on the Info tab.

 Select the patient then click on the Edit Patient
icon on the tool bar.

 Go to Patient menu and select ‘Find Patient’.
Highlight patient and click on ‘Edit Patient’.

In the ‘Edit Patient’ screen, edit patient data and click on the
‘Save’ button.

Navigate Patients
The scheduler allows you to move back and forth among
patients previously loaded. Much like internet browsers
have a back and forward button. There are two Navigation
options.

 To move to the previous patient record, select

Previous Patient in Patient Menu.
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 To move to the next patient record, select Next

Patient in Patient Menu.

Deleting Patients
IMPORTANT: Patients cannot be deleted from the
Scheduler if the patient has claims in EZClaim’s medical
billing software.

1. Use the instructions to Edit the patient record
2. Click the Delete button.
3. Click Yes to the confirmation.
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Appointments

Creating Appointments
1. Optional: Select ‘Appointment Template’ in the side

bar.
2. On side tool bar, select a patient.

3. ‘Drag and Drop’ the small patient icon into the
appointment time.

4. Resize the appointment by dragging the borders up
or down if needed.

5. Optional: Right click the appointment to change the
status or double click the appointment to edit all
properties of the appointment.

Reschedule or Copy an Appointment
Appointments can be rescheduled or copied to another date.
Right click the appointment, select ‘Schedule a copy of this
appointment’ then select the correct date.

Editing Appointments
Methods for Editing appointments are:

 ‘Drag and Drop’ the appointment to a different
appointment time.

 Resize appointment on main screen using the
mouse to add or decrease appointment time.

 Right click on appointment time to set options.
 Double click on patient’s appointment to open

Appointment dialog box.
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Changing the Start and End Times
You can click on any part of the field to change.
Example, click AM and use the arrows to change to PM
or click the hours or minutes to change using the arrows.

Finding Appointments
Finding a Patient’s Appointments

1. Select the patient in the patient selection drop down
in the side tool bar.

2. Click the APPT tab to view the appointment list.
Double click to jump to that appointment

Finding a Day’s Appointments

Appointments may be viewed on the main screen by
highlighting a date on the side tool bar calendar. Dates may
also be viewed by going to the ‘Go To Date’ on the menu
bar.
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Deleting an Appointment
Right click on any Appointment and select ‘Delete.’ You can
also click once on the appointment and press the delete key
on the keyboard. When you click the Delete key, you will be
asked to confirm if you wish to delete the appointment.

Attendance Status
Appointments can be assigned different attendance
statuses. To assign a status, right click the appointment and
select Attendance, another menu pops up. Select the
appropriate status. An icon will appear within the
appointment window.

Reminders
Reminders can be set for each appointment. Double click
the appointment to edit and check the reminder check box.
Set the amount of time before the appointment occurs for a
popup reminder.
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Once the reminder popup appears, you can dismiss the
reminder or ‘snooze’ the reminder for a period of time.

Appointments with reminders have a special icon showing
that a reminder has been set.

Recurring Appointments
If you would like to schedule an appointment to reoccur,

double click the appointment and use the button
on the edit appointment screen. This will open the
Appointment Recurrence screen.
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Enter the recurrence pattern and click OK to return to the
Appointment edit window. When you click OK to close the
appointment, you will be asked to confirm the appointments
to create.

This window shows the appointments to be created and
helps you determine if there are any conflicts with existing
appointments. Click Accept when you are finished.
Appointments will be created and shown in the schedule.



EZClaim Appointment Scheduler Appointments  31

Editing a Recurring Appointment
If you need to edit a recurring appointment, double click the
appointment. At the bottom of the screen you are given an
option to apply the changes to other appointments in the
recurrence.

1. Check the box on the left
2. Select the appropriate choice
3. Click OK.
Individual appointments within a recurrence can be moved
around a schedule without affecting the others. This helps
avoid conflicts or adjust to the patient’s available time.
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Blocking Appointments

Blocking appointments are used to block out time a resource
is not available. A blocking appointment can be a recurring
appointment so it’s easy to set a blocking appointment for
the office lunch time.

Methods to set a ‘Blocking Appointment’:
 Right click a time in the scheduler view and select

‘New Blocking Appointment’
 Click ‘Appointment’ on the menu bar and select

‘New Blocking Appointment’.

The blocking appointment window allows you to set the
color, time and duration. Use the Recurrence pattern and
Range of recurrence to set how many times and on what
days the appointment occurs.
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Edit a Blocking Appointment
Methods to edit a blocking appointment

 Double click the blocking appointment in the
calendar view

 Right click and select Edit Series

Delete a Blocking Appointment
When deleting a blocking appointment, there are two options
to delete. You can delete the whole series or just the single
blocking appointment. Make the appropriate selection and
click OK.
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Printing a Schedule

Methods to print a schedule:
 Use the tool bar icons to print or preview a schedule
 Click the File menu and select ‘Print Schedule…’

What appointments will be Included on the Printout?
The ‘Print Schedule’ function will include all the resources
and appointments shown in the current view.

If you are in ‘Day View,’ the printout will include a single
day’s appointments. If you are in ‘Week View’, then the
printout will show a week’s worth of appointments.

Use the tool bar icon to print the schedule.

Use the tool bar icon to preview the schedule.

The standard schedule print out is a graphical representation
of what you see on the screen. To change the schedule to a
different report, see “Profiles Tab” on page 18. The setting
is the ‘Schedule Printout’ option in the ‘Printing’ section.
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View Options

View options are configured with the side bar options and
tool bar icons. The two main options are what days are
visible and what resources are showing.

Calendar Views

To select the desired calendar view, click on one of the
following Icons. Click on any of the icons to switch between
views.

Click on ‘Day View’ to view one day only.

‘Work Week View’ for setting work week
options.

‘Month View’ to view the whole month.

The highlighted days on the side bar calendar will change to
reflect your view format. If you need to change to a different
day, week, or month, simply select the date.

Date Navigation
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You can use the forward and back tool bar icons to jump
back and forth between previously viewed dates.

Work Day Visibility

When working in ‘Work Week View’, a new menu option
called ‘Work Day Visibility’ is available. Clicking this menu
allows you to hide days that the office is closed. Uncheck
the days you would like hidden.

Resource Selection
To change the doctors (or other resources) showing on the
screen, use the resource selection drop down on the side
bar. Resources are setup in the program setup window
(Tools > Program Setup), see “Resources Tab” on page 15.

One or more resources may be selected and will be viewed
on the scheduler to the right. Example: If Sample Doctor and
X- Ray Room are checked, both Resources will be viewed
on the scheduler.
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Backup and Restore

IMPORTANT: The backup and restore functions affect
BOTH the EZClaim medical billing software and the
scheduling software. When you restore data, be sure you
understand that you are also restoring billing data to an
earlier date.

All the scheduling and billing data is contained in a single
file. You cannot partially backup or restore data. When data
is restored, you are restoring back to a point in time. Any
data entered after that time will not be available.

Click the File menu and select ‘Backup/Restore Utilities’

Backup Data

The Data Backup Screen allows backup of both the
scheduling data from EZClaim Appointment Scheduler and
the billing data from EZClaim. In order to backup the data,
you must be the only one in the system.

Browse – Allows selecting the location and filename of the
backup.
Backup Now – Backs up the scheduling and billing data.
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Restore Data

The Data Restore Screen helps to restore both the
scheduling data from EZClaim Appointment Scheduler and
the billing data from EZClaim. In order to restore the data,
you must have an exclusive access to the database.

Browse – Allows selecting the location of the restore file.
Restore Now – Restores both the scheduling and billing
data.
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Reports

Open the reports window by clicking the File menu and
select Print Reports…
Reports can be printed with various criteria. Before printing
you must select the report you wish to print.

1. In the Reports Screen, select the report to print.
2. If a date range is required, check the From and/or

To box then select the dates. If you would like to
see all appointments from today forward then you
would only check the ‘From’ box. The current date is
automatically entered. You can also use the
‘Previous Month’, ‘This Month’, and ‘Next Month’
buttons for quickly selecting a date range.

3. Select Resources from the drop down list. If you
wish to print the reports of all Resources, select the
‘All’ button. You can also choose to select the same
resources that are visible on the main screen by
clicking on the ‘Visible’ button.

4. Select Patients from the dropdown list. If you wish to
print a report of all Patients, click on the ‘All’ button.
If you wish to print only the currently selected Patient
on the main screen, click on the ‘Active’ button.
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5. Select the status of the Appointment Attendance
from the drop down list.

6. Select Appointment Transfer Status from the drop
down list.

7. If you wish to preview the report before you print,
click on ‘Preview’ button.

8. Finally, click on ‘Print’ button to print the report.

Superbill Report – Refer to the topic “Superbill Report” on
page 50 for information on customizing the superbill for your
practice.
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Appointment Templates

Overview
Appointment Templates speed the creation of different
appointment types. Example: New Patient appointment
characteristics such as background color might be different
than for repeat appointments. These templates allow you to
define a set of characteristics such as Background, Border,
Duration, etc.

Creating Simple Appointment Templates
Appointment templates are created in the Program Setup
window. Click the Tools menu and select Program Setup.
Click the Appointment Templates tab.

1. Click on the ‘New’ button or highlight and then edit
the Generic Appointment Template.

2. Enter a ‘Template Name’.
3. Select a background color.
4. Select a border color.
5. Select a Duration
6. Click the Save button.
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See “Using Appointment Templates” on page 43 for
more information.

Creating Advanced Appointment Templates
When creating appointments using templates, the program
has the ability to insert data from the patient’s record (the
data you see on the ‘Edit Patient’ screen). This can include
insurance information, patient contact details and so on. It
can also include text you enter such as ‘Make sure to get
new insurance information’. When creating advanced
appointment templates, you will tell the program what text to
enter and which fields from the patient record will make up
the header or notes.

The ‘Appointment Heading’, ‘Subheading’, and ‘Notes’ fields
have the capability of pulling data from the patient record.
When a template is first created, the program will
automatically enter ‘LastName, FirstName M’ into the
Appointment Heading field. This can be edited if needed.

In this example, we will create a Subheading that shows the
patient’s home phone number.

1. Create a new template by clicking the button.
2. Enter ‘Phone Number Template’ into the ‘Template

Name’ field. The screen should look like this:

3. Click the button next to the Subheading field.
This will open the Subheading editor screen.

4. Confirm the cursor is in the Subheading Format field.
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5. Enter the following text: ‘Phone: ’

6. With the mouse, double click the ‘PRIMARY PHONE
NUMBER’ item from the list on the left.

7. This will cause [PRIMARY PHONE NUMBER] to be
entered into the Subheading Format field.

8. Click OK to save the changes. The screen should
now look like this:

9. Click the button to save the template.

10. Click the button to close the Program
Setup window.

11. When you use the template to create an
appointment (see Using Appointment Templates), it
will look like the following. The [PRIMARY PHONE
NUMBER] was replaced with the phone number in
the patient’s record:

IMPORTANT: Information used from the patient record is not
linked. In our example, this means if someone changes the
primary phone number in the patient’s record, the program
will not update the phone number shown in the appointment.

Using Appointment Templates
In the side bar, use the dropdown to select an appointment
template. When an appointment is created, the currently
selected template will be used to create the appointment.
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Applying a Template to an Existing Appointment
If needed, you can apply a different template to an existing
appointment or even reapply the same template (to update
any changed information).

1. Double click the appointment to open.
2. Use the Template drop down to select the template

to apply.

3. Click OK to save your changes or Cancel to undo
them.
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Appointment Waiting List

To open the waiting list, click the Appointment menu and
select Waiting List.

The Patient Waiting List Screen provides an easy way to
enter and manage the patients waiting for appointments.

To view the patient’s contact phone numbers, click the
patient’s name and a drop down will appear showing the
phone numbers.

You can sort the grid by clicking on the column headings.

Adding a Patient to the Waiting List
In the column where it says ‘No Patient Selected’, enter the
patient’s name (you may need to scroll down to the bottom
of the list if it’s not visible). You can also use the drop down
to select from the list. Please note the patient must already
be in the system to be added to the waiting list.

Fill in the remaining columns according to the patient’s
availability and the appointment length.

Removing a Patient from the Waiting List
You can remove a patient from the Waiting List by clicking

on button on the specific patient row.
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Using the Waiting List
The easiest way to use the waiting list is to right click on a
‘hole’ in your schedule and select Check Waiting List….

The program will then show a list of patients available for
that time slot with that resource. Highlight the patient and

click the button to add the
appointment.

If needed, you can modify the ‘Waiting List Filter’ options at
the top of the screen. To clear the filter and show all the

patients, click the button.

Printing the Waiting List

Click the button to print a report of the waiting
list
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Tracking Authorizations

Overview
EZClaim’s Scheduler program can track patient visit
authorizations. It does so through the use of an
authorization library that holds the patient’s authorization
numbers and the assigning of an authorization number to
each appointment.

Authorizations are tracked on a patient by patient basis. Be
sure the ‘Track Authorizations’ is checked on the ‘Edit
Patient’ window.

If you no longer want to track authorizations for a patient,
uncheck the ‘Track Authorizations’ box on the ‘Edit Patient’
screen. If authorizations exist for the patient, a confirmation
box will appear asking if you are sure you want to delete the
patient’s authorizations from the library.

Authorization tracking can be disabled system wide by
unchecking the ‘Track Authorizations’ check box on the
library window

Authorized Visits Library
Click the Tools menu and Authorized Visits Library to open
the window.

Enter the patient name, authorization number, date range
and the number of allowed visits. The visits remaining will
be calculated automatically.

If you would like to turn off authorization tracking, uncheck
the ‘Track Authorizations’ check box.
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Click the + button to show the appointments the
authorization is assigned to.

Transfer to Claim – Uncheck this box if you do not want the
authorization number to be transferred to EZClaim. See
“EZClaim Integration” on page 52 for more information.

Assign to Appts – Click this button to assign the
authorization to existing appointments that fit the
authorization time frame.

Assigning Authorization Numbers
Authorization numbers are automatically assigned when an
appointment is created. The program will assign the most
likely number from the list in the authorization library. It first
looks for the correct patient, then the date range, then the
number with the least remaining visits.

If you would like to manually remove or change the
authorization number, you can double click the appointment
then edit the authorization number.

Use the ‘Clear’ button to clear the auth number or the ‘Auto’
button to assign a number.

Assigning Authorization Numbers after the
appointments have been created

If the authorization number is entered AFTER the
appointments have been created, click the Assign to Appts
button. The program will look for the patient’s appointments
that fall within the authorized date range and automatically
assign the correct authorization number. If an appointment
exists with an invalid authorization number, the new, valid
number will be assigned.

Printing the Authorization Library
Click the Print button to print the grid currently being viewed.
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Determining the Authorization Status
If a patient has authorization tracking turned on, their
appointments will show an icon representing the authorized
status.

- Appointment has an authorization number and is valid
meaning it’s within the date range and is in the number of
allowable visits.

- Appointment has an authorization number, it is valid,
but it’s one of the last three authorized visits, you may need
to obtain a new authorization soon.

- Appointment is not authorized. This could mean it falls
outside the date range, surpasses the number of visits
allowed, or does not have an authorization number
assigned.
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Other Advanced Features

Patient Payments
The scheduler can record a patient payment and print a
receipt. During the checkout process, double click the
patient’s appointment and enter the amount paid, reference

number, then click the button. If you transfer
appointments to EZClaim, the payment will be transferred as
well. See “EZClaim Integration” on page 52 for more
information.

Superbill Report
The Superbill report can be customized by editing the
superbill.rtf file located in your system. The file is in the
same location as the scheduler database. The database
location can be determined by clicking the Support/Help
menu and clicking ‘About EZClaim Appointment Scheduler’.
In this example, the superbill.rtf will be located in the
C:\Program Files\EZClaim directory.
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Use any word processor to edit the superbill.rtf file. Be sure
to save the file in the rtf format.
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EZClaim Integration

The scheduler shares the patient information with EZClaim.
Changes made to the patient information in EZClaim are
reflected in the Scheduler and the other way around,
changes made in the scheduler are reflected in EZClaim.

There are also some shared libraries. Both the
Physician/Facility library and the payer library are available
in the Scheduler, even though the scheduler does not
require either of the libraries to be used, it’s convenient for
the user to be able to populate extra data within the
scheduler without having to open the EZClaim program.
EZClaim considers the medical billing software to be the
controller of information. Therefore, you are unable to delete
any of the physician/facility or payer library entries. This
must be done in EZClaim.

One of the benefits of using the Scheduler and EZClaim
Medical Billing together is the ability to transfer appointments
and generate claims. The transfer function makes use of
EZClaim’s claim templates feature. Even though this is not
required, claim templates may help in preventing extra data
entry once an appointment has been transferred to billing.

Locking Patient Records
If the billing person would like the patient record to be
locked, this is possible by checking the ‘Lock patient record’
check box in EZClaim on the Payers/Other Info tab. If this
box is checked, the scheduler program can view patient data
but is unable to edit it. The scheduler will show a message
on the Edit Patient screen saying ‘This record has been
locked in EZClaim.’

Transfer to EZClaim
To transfer an appointment to EZClaim, simply right click the
appointment and select Transfer to EZClaim.
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This will bring up the transfer claim window.

There are options available that determine how the claim will
be created in EZClaim:

Create a new claim or Add to existing claim
If the ‘Add to existing claim’ is selected, the program will find
a patient’s claim that has not been printed or exported and
will add the services to the existing claim. ‘Create a new
claim’ will create a new claim regardless of any existing
claims.

Transfer Appointment Using
This setting allows you to pick the template that contains the
services lines that will be used when creating the claim.

 <Use Default Values> - This setting will add a single
line item based on the default values found on the
Physician/Diagnostic screen in EZClaim.

 <Use Previous Claim> - This setting will duplicate
the previous patient claim but change the date to
match the appointment’s date.

 Existing Claim Template – This setting will use the
template’s service lines to generate the new claim.
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Claims templates are setup and managed within
EZClaim’s medical billing software.

Claim Properties
The claim properties can be set as the user requires. The
rendering provider, facility, and diagnostic codes may be set
with the claim template but can be changed before the
transfer takes place.

Billing Item Properties
The billing item properties show the service lines that will be
created during the transfer. When you have ‘Create new
claim’ checked, all the service lines will have ‘New’ in the
first column. If you are adding to an existing claim, the first
column will show ‘Existing’ and ‘New’

Payer Library

The Payer Library Screen has the details related to the
Insurance Payer. It has the following details.

 Payer Name
 Street Address
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 City/State/Zip / MI
 Telephone
 Payer Notes
 Payer ID
 Office Num
 INS Type Code

Add/Save – Allows to Add or Save the information related to the
Payer Library Screen.

Edit – Allows to Edit the information related to the Payer Library
Screen.

Physician Library

The Physician Library Screen allows you to enter
information related to the physicians. It has the following
details.

 Physician / Organization Library Entries
 Full Name
 Classification
 Last Name or Organization Name if record is a Non

Person Entity
 First Name
 Middle



56  EZClaim Integration EZClaim Appointment Scheduler

 Address
 City State Zip
 Telephone
 Email
 Fax
 NPI
 Specialty Code
 Tax ID Type
 Tax ID
 Notes

Additional ID Numbers include the following details

 Payer
 ID Type
 ID Number
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